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1 – Overview
The STNet Control Center software provides users with a simple tool to monitor and configure SoundTube  
Dante™-enabled devices. It detects connected devices on the configured network automatically showing them 
in a device list. Once a device is discovered, STNet Control Center can present further details about the device.  
STNet Control Center is also used to configure the device settings such as gain and phantom power.  
This manual is designed to give the user a guide on how to use the STNet Control Center to monitor and  
configure Dante™ devices on a network.

1.1 – How to Use STNet Control Center
The steps required to use the software are as follows:
• Install the application
• Run the application (section 3 – Application Features and Functions)
• Configure the network adapter (see section 3.7.2– Network Interface)
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2 – Installing the Software
*Note: It is recommended that the installation instructions be read prior to attempting installation of the software.

2.1 – PC Requirements
•  Windows 7, 8, 8.1, or 10 (32- or 64-bit versions)
•  Wired Ethernet Network Interface Card

2.2 – Installation Method
The software is installed using a single install file 
which is available from the Downloads Page of the 
MSE Audio/Soundtube website (mseaudio.com/
product-downloads) under the “STNet Software” 
tab (1)

To install the application, double click of the ap-
plication EXE file to start the application install. At 
any point during this installation prior to actually 
installing the files, the installation may be stopped 
by clicking on the “Cancel” button. (2)

The application is installed by default into C:\Pro-
gram Files (x86)\Soundtube\STNet Control Center. 
This location may be changed by clicking on the 
“Options” button.

A new default location can be typed into the box 
or click the “Browse” button to browse for the 
new location. Click OK to accept any changes. 
Click “Cancel” to undo any changes. (3)

To activate the “Install” button, read the license  
agreement and if you agree, check the “I ac-
cept…” option. Finally, click the “Install” button to 
initiate the installation of the files.

1

2

3



STNet Control Center User Manual 
Version 1.1.0.4

6© SoundTube LLC 2022

At this point, Windows may pop up a User  
Access Account window. If it does, click 
the“Yes” button to allow the installation to  
continue. (4)

The installer will then begin copying files and 
display the progress of the installation.

After this process is successfully completed, 
click “Close”. (5)

The installation will create a program group and  
various shortcuts including one to run the  
program. All of the icons are located under  
Start Menu -> Programs ->Soundtube ->  
STNet Control Center.

5
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3 – Application Features and Functions
When STNet Control Center is opened, it will check what network adapter was previously selected and see if it 
is still valid. If it is, STNet Control Center will start the main application and begin running automatically.
However, if this is first time STNet Control Center is being run or the application was previously run in non-net-
worked mode, or STNet Control Center determines the previous adapter is found to be invalid for any reason, 
STNet Control Center will first pop up a message asking if the user wishes to continue using the application 
in non-networked mode with limited functionality. Selecting “Yes” to this message will open the main applica-
tion in non-networked mode with all the networking features disabled. For full functionality, select “No”. At this 
point, the “Network Interface Selection” window will pop up.

3.1 – Network Interface Selection
The drop-down list will contain a list of select-
able network adapters. There will always be a 
“None” option at the top that allows the software 
to be used in non-networked mode should that 
be necessary. (6)

*Note: STNet Control Center must be used with a 
wired network card. If a USB to Ethernet adapter is 
used, the USB to Ethernet adapter must be attached to the PC otherwise STNet Control Center may not start up correctly.

If the desired adapter is not found in the drop-down list, select the “None” option to get the main application 
window open. Once the issue with the network card has been diagnosed and fixed, use the “File” -> “Change 
Network” menu or the “Network Configuration” button on the button bar to re-open the “Network Interface 
Selection” window again to check if the correct adapter is now listed.

Once the desired interface is selected, click OK and if all is well, STNet Control Center will then open the main 
application window.

*NOTE: Windows allows users to configure multiple IP addresses to a single network adapter. However, this features is not 
supported by either the Audinate tools such as Dante™ Controller or STNet Control Center Control Panel. Network adapt-
ers used to connect to a Dante™ network must either be set to get a dynamic IP address or have a single static IP address.

The network interface can be changed at any time while the application is running.

6
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3.2 – Main Application 	
		  Window
The application is organized into the 
following sections:
• Menu and Tool bar
• Dante™ Device List
• Available Domains  
	 (Dante Domain Manager™)
• Application canvas
• Status Bar

At the top are the menus and a  
button toolbar. These allow access 
to various application functions. (7) 
The toolbar has a default set of  
buttons but these may be  
supplemented by additional buttons 
as other application features are 
used. On the left side of the  
application window is the DDM server and device list. The available domains shows any available DDM servers 
and allows you to login. The device list shows a list of the detected devices and their current state. The main 
area of the application window is a canvas which will populate with various controls as the application is used. 
Finally across the bottom is a status bar which shows application status messages, errors and warnings.

7
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3.3 – Dante Domain 
Manager™ Available 
Servers
The Available Servers dropdown 
displays any Dante Domain Manag-
er™ (DDM) servers on the network. 
When selected, a prompt will show 
on the main window to allow login to 
the domain. (8)

3.4 – Dante™ Device List
The Dante™ device list displays all 
Dante™ devices from any manufac-
turer that are detected on the active 
network interface. (9) Devices are noted in different ways depending on their status as follows:

• Red, strikethrough - Device previously detected that is longer on the network or powered down or  
	 may have communication issues (see following paragraph).
• Red, no strikethrough - Device with a communication issue (see following paragraph).
• White, Italicized - Non-SoundTube device.
• White, Bold, non-italicized - SoundTube device that is good to go and has configuration
capabilities that STNet Control Center can be used to change.

All SoundTube devices should appear in white. For SoundTube devices that appear in red that have not simply 
been disconnected from the network or powered down, it is likely that STNet Control Center has a communica-
tion issue with that device. 

If it is just a single device then a recent change of device name can cause 
this. A refresh of the device list should fix that (note a single refresh may not 
immediately work as it takes some time for STNet Control Center to  
determine the device with the old name is no longer available). Otherwise,  
the most likely cause of an issue is an IP address conflict where PC and  
device have IP addresses in different ranges.

However, if all SoundTube devices in the list indicate red, that may be  
something more serious. The following issues are known to have caused problems:
• IP Address issue – The PC has an IP that not in the same IP range as all the devices
• 3rd party Firewall / Anti-Virus / Internet Security applications blocking STNet Control Center access to/from 
the network
• Multicast filtering setup on network that prevents traffic from reaching the PC
The device list can be filtered using search box or the “Show Only” filter option. The “Show Only” filter will ad-
just the list to show only a specific type product. The search box attempts to match the text in the search box 
with any part of a devices name in the device list. The search box is case sensitive.

8
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3.4.1 – Dante™ and Parameter Locks
With V3.10 firmware, Dante™ devices have a facility that allows their Dante™ parameters to be locked to pre-
vent changes (see Dante™ Controller help or the Audinate website for further details of this feature). The locked 
state can only be applied or removed using Dante™ Controller. Some SoundTube devices also now support a 
parameter lock to restrict access to the non-Dante™ device features like phantom power and gain. If a device 
has either its Dante™ lock or parameter lock enabled, a padlock icon will appear next to its name.

*Note: Any active locks on a device also impact what features such as Load/Save presets and firmware updates can be 
used on a device.

3.4.2 – Channel Names
A device in the device list can be expanded to show or hide its Dante™ audio channels by either double-click-
ing on the device name or by clicking on the small “+” icon to the left of the device name. Any transmit chan-
nels the device has are shown prefixed with a [TX] and any receive channels are shown prefixed with an [RX]. 
The channel names can be collapsed again by either double-clicking on the device name or by clicking on the 
small “-” icon to the left of the device name.

When the channels names are being shown, the application allows for the channels names  
to be changed. Right-clicking on a channel name will be show the “Rename” context menu.

*NOTE: Dante™ relies on the device name and channel names for audio routing. Changing the Dante™ channel names 
therefore may cause audio subscriptions to be lost and that audio will then cease to be transferred. Those subscriptions 
will need to be re-built using the new channel names for that particular audio to begin flowing again.

Rename
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3.4.3 – Device Context Menu
Right clicking on a device will open the device context 
menu. (10)

“Status” shows the device status within the applica-
tion. This field is typically used for
diagnostic purposes. For SoundTube devices that are 
working correctly, the “Status” should show “Device 
Ready”.

The “Device Info” option has a sub-menu that shows 
specific information about the device. (11)  
The Information shown includes the manufacturer, 
model name, control type (if known), MCU version (if 
known), and the device IP address. Not all fields may 
be populated depending on the devices “Status” and 
what information is available. SoundTube devices 
should populate all fields.

Clicking the “Identify Device” option allow devices 
on the network to be visually located. This feature 
will flash the status LEDs. Power LED, or front panel 
display of the selected device for approximately five 
seconds to aid identification of the physical
location of a device.

Clicking the “Configure Device” context menu item 
will open the associated configuration plug-in for the 
selected device. This option will only available on 
supported devices that have a suitable plug-in available. Access to a supported devices plug-in can also be 
gained by double-clicking on the device name in the device list too. Information about device specific plug-ins 
can be found in Section 4.

10

11



STNet Control Center User Manual 
Version 1.1.0.4

12© SoundTube LLC 2022

3.7 – Menu and Tool Bar Functions

3.7.1 – Refresh Device List
This feature can be accessed from the toolbar  
button (12) or an option in the “File” menu. It will  
refresh the current Dante™ device list shown on the 
main screen of the application. The discovery process 
will only detect devices that are connected to the actively selected network adapter within the application.

*Note: If the application is detecting devices but all of the devices are shown in red, that indicates a network conflict and 
is likely the result of mismatched IP address configuration between the actively selected network interface card and the 
target Dante™ devices.

3.7.2 – Network Interface
Allows the user to select a different network interface to use with the application. See section 3.1– Network 
Interface Selection for details.

3.7.3 – Dante™ Controller
The STNet Control Center provides a configuration tool for the device specific parameters of SoundTube de-
vices. For general device routing or Dante™ network configuration, SoundTube recommends the use of Dan-
te™ Controller software from Audinate. To simplify system configuration, Dante™ Controller can be launched 
directly from the STNet Control Center application by clicking the “Dante™ Controller” button or the “Dante™ 
Controller” option of the “File” menu.

If this option is being used for the first time, it will ask for the location of the installed Dante™ Controller soft-
ware. If the Dante™ Controller application is not installed on your computer, you may download a copy at the 
following link.

https://www.audinate.com/products/software/Dante™-controller

Once the program location has been identified, Dante™ Controller will open. Subsequent uses will simply 
open the Dante™
Controller application.

3.7.4 – Help
The help menu provides access to information about the application version, application plug-in versions and 
also application help. The application version and plug-in version information can only be accessed via the 
Help menu while the application help can be accessed via the Help menu or the Help button on the toolbar.

12
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3.8 – Multi-Device Preset Load
In order to simplify device  
configuration in systems deploying a 
large number of common SoundTube 
devices, the Multi-Device Preset 
Load tool allows the user to select 
a device preset that can be applied 
to multiple devices in one update 
process. This is accessed through an 
option in the “Tools” menu. (13)

When the “Multi-Device Preset Load” 
menu item is selected, a pop-up  
window appears asking for the  
location of a .CFG file. All .CFG files are generated when executing the “Save Presets to File” functionality for a 
device described in section 4.2.1.2. Once the file is loaded, the main canvas will show the multi-device preset 
load plug-in. The application will identify all compatible devices which can accept the preset file. These  
devices will be shown in list along with a progress bar for the preset update progress.

*Note: Any devices that have their parameter lock active will have a padlock icon and the progress bar replaced with text 
warning the device is locked.

Select one or more devices by clicking on the checkbox for each desired device. Alternatively, all devices can 
be selected for preset loading by pressing the “Select All” button. Once the desired device selections have 
been made, press the “Start” button to initiate the preset loading process. If at any time the preset loading 
process needs to be stopped or exited, press the “Close” button.

13
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3.9 – Smart Firmware Updater
For STNet Control Center, a feature 
was integrated that adds support for 
SoundTube device firmware updates. 
This functionality is accessed by 
selecting and launching the Smart 
Firmware Update from tools menu in 
the main application window. (14)

To use the updater, first click on the 
Select File button. This will open a 
file explorer window for selection of 
the desired firmware package. The 
smart firmware updater utilizes .SFU 
firmware packages. These files are 
available on the SoundTube website for all supported products (mseaudio.com/product-downloads).

Once the desired file has been selected, the application will search for devices that match the selected firm-
ware update package. The application will also determine the relevant features that require updates on each 
device.

The discovered device list shows the following information about the device.
• Device Name
• Product Version
• Device Mode – This control allows selection between –C and –U firmware option support for  
	 proper integration with the target DSP and/or control system used in the product installation
• Status – Shows the number of required steps for the update based on the current state of the device
• Progress – The top progress bar shows the progress for the current step in the update procedure and the 	
	 bottom bar shows the overall progress

*Note: If either the Dante™ lock or the parameter lock are active, the device will show up with a padlock next to it and the 
progress bar will be replaced by text indicated the device has an active lock. No updates will be possible in this device 
until the lock is removed.

To initiate an update, check the device or devices in the list with their associated checkbox and click on the 
“Start” button. The smart firmware updater will determine the appropriate portions of the device firmware that 
require updates, to override this functionality and force a complete update, select the “Force All Updates” 
checkbox.

The update process can be stopped at any time by pressing the “Cancel” button, however, in order to prevent 
device lockups the updater will continue until it is safe to cancel the overall update operation.

If a device fails during the update process it will be shown in red after updates to all other selected devices are 
complete.

14
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4 – Device Configuration
The main function of STNet Control Center is to allow configuration of device parameters for SoundTube’s 
products. While the plug-in for a particular type of product is specific to that type, there are some configura-
tion features that are generic across all plug-ins.

4.1 – Device Info
The Device Info panel is shown at the top of any 
plug -in and is usually accompanied with an 
image of the device. It contains information about 
the selected Dante™ device. (15)

There is also a checkbox to enable or disable  
a latching identify function. Unlike the Identify 
function on the device context menu of the device list, this Identify function is a toggle and will continue to 
perform the identify functionality until either manually disabled by the user, the plug-in is closed or by power 
cycling and resetting the device.

Dante™ Lock – The Dante™ lock status is indicated by a padlock icon. If the icon and text are not shown, the 
device is not programmed with a version of firmware that supports this feature 

*NOTE: Firmware updates are available that support this feature for all SoundTube devices. 

If the Dante™ lock is active, the padlock icon will be shown locked and no changes to the audio routing or 
Dante™ network settings can be made. If the Dante™ lock is not active, the padlock will be shown unlocked. 

*NOTE: The Dante™ lock can only be removed or applied using Dante™ Controller.

Parameter Lock – When the parameter lock is active, device settings such as gain and phantom power are 
locked and cannot be altered. The parameter lock also blocks the firmware update and preset load  
functionality too. To allow changes to be made, the parameter lock checkbox must be unchecked. However, if 
the Dante™ lock is active, the parameter lock state itself will be locked and cannot be changed. The only way 
then to unlock the device is to remove the Dante™ lock first.

Refresh - The “Refresh” button is used to refresh the on-screen settings of the device that is being configured. 
This is useful if there’s an external system or device such as a 3rd party control system that’s communicating 
with the device and altering settings after the settings on the device have been read by the STNet Control 
Center software.

15
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4.2 – Preset Configuration
Most devices feature preset capabilities for recalling a previously saved set of settings either from a file on the 
PC or from non-volatile memory on the target device. When a device is selected for configuration, if the device 
supports presets, a “Save Presets” button and “Load Presets” button will be added to the toolbar. (16)

4.2.1 – Save Presets
When the “Save Presets” button is pressed, the “Configuration Presets” dialog will open in save mode.

*Note: If the parameter lock is active, the device preset side will be greyed out as the parameter lock prevents any change 
to device settings. This lock must be removed before a preset can be saved to the device. This may require the Dante™ 
lock be removed first, if that is also active.

4.2.1.1 – Save: Device Presets
Current settings can be saved to a preset 
in non-volatile memory on the selected 
device. Use the dropdown list to select 
which preset the current settings will be 
stored to, then click the “Save to Device” 
button. On all SoundTube devices, the 
“Default” preset option is used to store 
the power- on defaults. (17) Any settings 
stored in the “Default” preset will be 
re-loaded upon the speaker powering up 
(like in the event of a system reboot or 
power drop). The power-on defaults can 
be reset back to factory settings with the 
“Restore Defaults” button.
*WARNING: Use this with care!

4.2.1.2 – Save: File Presets
Current settings can also be stored off to a file. The file created can be used to apply the same settings to  
multiple devices (see Multiple Device Preset Load feature). It can also be stored off as a back-and recalled 
later if needed.

16
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4.2.2 – Load Presets
When the “Load Presets” button is 
pressed, the “Configuration Presets”  
dialog will open in “Load” mode. (18)

*Note: If the parameter lock is active, loading 
a preset will not be possible as configuration 
changes are blocked. A warning will instead 
pop up warning the user that the parameter 
lock is active. This lock must be removed be-
fore a preset can be loaded. This may require 
the Dante™ lock be removed first, if that is also 
active.

4.2.2.1 – Recall – Device Presets
Update the current settings from a previously stored preset in non-volatile memory on the device. Use the 
dropdown list to select the desired preset, then click the “Recall from Device” button.

4.2.2.2 – Recall – File Presets
Use the “Load from File” button to update the current device settings from a file which was previously saved 
using the “Save Preset to File” feature. Refer to the specific device configuration details for information on the 
preset capabilities of each device.

18
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5 – SoundTube IPD Speaker Configuration
Based on the model of SoundTube Dante™ speakers, there are two modes of setup:

• Biamp

• Full Bandwidth

5.1 – General Settings & Status

5.1.1– Pink Noise
Check the Enable box to output pink noise for diagnostic purposes. The volume level can be adjusted with the 
slider, entered into the text field, or using the up/down arrows. (19)

5.1.2 – Status
This section shows the current Amp, Temperature, and Speaker status levels.

5.1.3 – Device Info
This section provides information such as the device name, model, IP and MAC addresses, Location, and 
firmware version.
The Location field is editable for organization of multiple devices.

5.1.4 – Older Preset File
Load preset files from the previous DNA Control software here.

19
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5.2 – BiAmp Mode – Amp Setup

5.2.1 – Power Mode
This section shows the status of the currently used power source. The 40W Enable checkbox should only be 
selected when used with Soundtube’s switching hardware that supports the 40W mode. (20)

5.2.2 – Impedance Monitor Configuration
This section shows the current status of the speaker voice coil. The impedance monitor will report voice coil 
failures in response to the built-in speaker self testing as a pass or fail indication. A green LED indicates the 
speaker is functioning properly, a red LED indicates the speaker voice coil has failed or is approaching failure.

20
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21

5.3 – BiAmp Mode – DSP Setup

5.3.1 – Input & Output Controls
• The input level can be adjusted with the slider, entered into the text field, or using the up/down arrows.
• The output level can be adjusted with the slider, entered into the text field, or using the up/down arrows. 
There is also a mute option and phase invert. (21)

5.3.2 – EQ Section
The EQ section includes High and Low Pass filters with frequency sliders. Bands 1-8 have adjustable frequen-
cies from 10Hz to 22kHz. Gain is adjustable from -30dB to 6dB. The BW slider adjusts to cover a narrow to 
wider slope for the assigned frequency.
• Bypass EQ – passes all audio without EQ applied
• Reset EQ – resets all EQ band gain settings to 0dB

5.3.3 – Delay
In large systems with multiple speakers to cover a large area, it is necessary to set a delay on the supplemen-
tal speakers for coherence and synchronization of the sound. Adjustments are made via the slider or text field.
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5.4 – Full Bandwidth Mode – Amp Setup

5.4.1– Power Mode
This section shows the status of the currently used power source. The 40W Enable checkbox should only 
be selected when used with SoundTube’s switching hardware that supports the 40W mode. (22)

5.4.2 – Impedance Monitor Configuration
This section shows the current status of the speaker voice coil. The impedance monitor will report voice 
coil failures in response to the built-in speaker self testing as a pass or fail indication. A green LED  
indicates the speaker is functioning properly, a red LED indicates the speaker voice coil has failed or is 
approaching failure. The checkboxes allow each external speaker output to be included or ignored when 
reporting the impedance monitoring results.

22
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5.5 – Full Bandwidth Mode – DSP Setup

5.5.1 – Input Mode
The full bandwidth output 
speaker models include 
an option to process  
Dante input from one or 
two channels. (23)

When “Single channel 
input” is selected, both 
processing chains for CH1 
and CH2 controls are fed 
with the same Dante RX 
channel.

When “2 CH channel 
input” is selected, each 
processing chains for CH1 
and CH2 controls are fed with a unique Dante RX channel (CH1 receives the first Dante RX channel and Ch2 
receives the second Dante RX channel).

5.5.2 – CH1/CH2
• CH1 – Master/Speaker3 – This tab allows configuration for the main and Speaker 3 output on the device.
• CH2 – Speaker 1/Speaker2 – This tab allows configuration for the Speaker 1 and 2 output on the device.

5.5.3– Input & Output Controls
• The input level can be adjusted with the slider, entered into the text field, or using the up/down arrows.
• The output level can be adjusted with the slider, entered into the text field, or using the up/down arrows. 
There is also a mute option and phase invert.

5.5.4 – EQ Section
The EQ section includes High and Low Pass filters with frequency sliders. Bands 1-8 have adjustable  
frequencies from 10Hz to 22kHz. Gain is adjustable from -30dB to 6dB. The BW slider adjusts to cover a  
narrow to wider slope for the assigned frequency.
• Bypass EQ – passes all audio without EQ applied
• Reset EQ – resets all EQ band gain settings to 0dB

5.5.5 – Delay
In large systems with multiple speakers to cover a large area, it is necessary to set a delay on the  
supplemental speakers for coherence and synchronization of the sound. Adjustments are made via the  
slider or text field.
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